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Disclaimer

The information contained in this document is for general informational purposes only and does
not constitute an offer, solicitation, invitation or recommendation to buy or sell any futures
contracts or other products or to provide any investment advice or service of any kind. This
document is not directed at, and is not intended for distribution to or use by, any person or entity in
any jurisdiction or country where such distribution or use would be contrary to law or regulation or
which would subject Hong Kong Exchanges and Clearing Limited (“HKEX”), Hong Kong Futures
Exchange Limited (“HKFE”) (together, the “Entities”, each an “Entity”), or any of their affiliates, or
any of the companies that they operate, to any registration requirement within such jurisdiction or
country.

No section or clause in this document may be regarded as creating any obligation on the part of
any of the Entities. Rights and obligations with regard to the trading, clearing and settlement of any
futures contracts effected on HKFE shall depend solely on the applicable rules of HKFE and the
relevant clearing house, as well as the applicable laws, rules and regulations of Hong Kong.

Although the information contained in this document is obtained or compiled from sources
believed to be reliable, neither of the Entities guarantees the accuracy, validity, timeliness or
completeness of the information or data for any particular purpose, and the Entities and the
companies that they operate shall not accept any responsibility for, or be liable for, errors,
omissions or other inaccuracies in the information or for the consequences thereof. The
information set out in this document is provided on an “as is” and “as available” basis and may be
amended or changed. It is not a substitute for professional advice which takes account of your
specific circumstances and nothing in this document constitutes legal advice. Neither of the
Entities shall be responsible or liable for any loss or damage, directly or indirectly, arising from the
use of or reliance upon any information provided in this document.

Additional disclaimer for CES China 120 Index Futures

CES China 120 Index (“CES 120 Index”) are calculated and / or disseminated by China Securities
Index Company Limited (“CSIC”) on behalf of China Exchanges Services Company Limited
(“CESC”). Neither CESC nor CSIC guarantee (expressly or impliedly) the accuracy, completeness,
timeliness or fitness for a particular purpose of the CESC Index and/or the information contained
therein; nor do they accept any liability for any damages, loss, costs or expenses suffered by any
person arising from the use of the CESC Index and/or the information contained therein.
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Equity Indices Monthly Performance in November 2023

Sector Indices vs HSI / HSCEI

Index Name

HSCEI

HS Mainland
Banks Index

HSI

MSCI China A 50 Index

-3.2%

-0.1%

oo |
oo |

CES120 vs China Theme Indices

Index Name

FTSE A50 Index

CSI 300 Index

CES120 Index

-2.0%

-2.1%

-2.4%

% Change % Change
Equity Index Futures Access Codes
Vendor HS Mainland Banks CES 120 HSI HSCEI
Bloomberg BMWA CESA HIA HCA
Refinitiv 0#HMBI: 0#HCHH: 0#HSI: O#HCEL:
WIND MBIF CHHF HSIF HHIF
ET Net MBI CHH HSI HHI

Data Source: Bloomberg
As at 30 November 2023
Information for reference only
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Equity Index Futures & Options

Hang Seng Index (HSI) Futures & Options

HSI Products

(2023 vs 2022)

HSI Futures 143,434 (-6%)

Mini-HSI Futures 97,150 (-10%)

HSI Options 24,234 (-6%)

Mini-HSI Options 13,418 (+8%)

HSI Futures

. 4, +57%
Options 096 (+57%)

HSI Volatility 00)
Index Futures

HSI Dividend
Point Index
Futures

107 (+269%)

Data Source: HKEX
* Ol compared to previous year-end
Information for reference onlv

As at 30 November 2023

X

149,607 (+31%)

21,140 (+79%)

129,380 (+19%)

19,976 (+48%)

59,229 (+12%)

0()

9,521 (+2866%)

Av erage Daily Volume
(No. of Contracts)
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Equity Index Futures & Options
HSI Futures & Options

Hang Seng Index HSI vs VHSI Price Level

HSI & Top 5 Constituents

. Includes the largest and most ('000)
Index Description o ) .
liquid stocks listed in Hong Kong 19 - HSI VHSI - 28 120 HSI Index Tencent
Index Level 17,042.88 (As at 30 Nov 2023) 110 - HSBC —AlA
26 Meituan Baba
Index Volatility (30-Day Historical) | 26.8 18 - 100 -
Index Avg. Day High-Low Range 236.12 (Nov 2023) 24 90 -
HSCEI Correlation (2023) 0.987 17 - 30 -
- 22
70 -

Hang Seng Index Futures 16 , , 20 60

Sep-23 Oct-23 Nov-23 Sep-23 Oct-23 Nov-23

HK$50

Contract Multiplier

Notional Value (1 Contract) HK$0.85Mn (As at 30 Nov 2023)

Call

Transaction Cost*

ransaioncost |- _

Stamp Duty N/A § §
— 31.0 @

Trading Fee HK$10 / contract 3 X
& o
v 24.0 =

SFC Levy HK$0.54 / contract = Z
“ 5

Commission Rate Negotiable 3 17.0 S
© =
£

Margin as of 24 Nov 2023 HK$54,300 100

0 1 2 3 4 5 6
Open Interest (‘000)

Data Source: HKEX, Bloomberg
* All calculations are in HKD and exclude commission fees
Information for reference onlv

As at 30 November 2023

X

Distribution of HSI Index Options Ol in Month-end

Put

0 1 2 3 4 5

Open Interest ('000)



Equity Index Futures & Options
Hang Seng China Enterprises Index (HSCEI) Futures & Options

HSCEI Products HSCEI Futures (YoY) HSCEI Options (YoY)

ADV
(2023 vs 2022) Av erage Daily Volume Open Interest  Average Daily Volume Open Interest
(No. of Contracts) (No. of Contracts)  (No. of Contracts) (No. of Contracts)
240,000 - == ADV (L-AXis) - 700,000 120,000 + ADV (L-Axis) r 2,800,000
Open Interest (R-Axi Open Interest (R-AXis)
J - 600,000 i - 2,400,000
HSCEI Futures 193,940 (+6%) 602,555 (-1%) 200000 [ e00.000 100,000 [ 200,000
160,000 - ! 80,000 - ! !
- 400,000 - 1,600,000
120,000 - 60,000 -
- 300,000 - 1,200,000
Mini H El 80,000 - 40,000 -
Fut SIS 10,535 (-23%) 5,673 (+12%) - 200,000 - 800,000
utures 40,000 - - 100,000 20,000 - - 400,000
0 - 0 0 L e e e e e e 0
N ND O A 9 N g
. ) S S S S S S
HSCEI Options 48,553 (+8%) 1,329,922 (+16%) v
HSCEI Futures (MoM) HSCEI Options (MoM)

.. Av erage Daily Volume Open Interest ~ Average Daily Volume Open Interest
Mln-l HSCEI 3,779 (+8%) 28,513 (+2%) (No. of Contracts) (No. of Contracts) ~ (No. of Contracts) (No. of Contracts)
Options 275,000 | s ADV (L-AxiS) - 800,000 80,000 - ADV (L-Axis) - 2,000,000

Open Interest (R-Axis) Open Interest (R-AXis)
HSCEI Fut 220,000 1 - 600,000 60,000 - - 1,500,000
utures
oo 35,536 (+83%) 1,097,453 (+49%) 165,000 - P
ptions - 400,000 40,000 - - 1,000,000
110,000 -

HSCEI Dividend 55,000 - - 200,000 20,000 - - 500,000
Point Index 1,298 (-5%) 85,256 (+48%)
Futures o7 [ ° 0 0

ol c S=>csoahn >

858828532588

2 2022 2023

Data Source: HKEX
* Ol compared to previous year-end
Information for reference onlv

As at 30 November 2023
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Equity Index Futures & Options
HSCEI Futures & Options

HSCEI HSI vs HSCEI HSCEI & Top 5 Constituents

. Comprises the largest and
Index Description P d

most liquid H shares 108 120 -
e===HS| em=——=HSCEI ———HSCEI = Ping An
Index Level 5,857.54 (As at 30 Nov 2023) 106 - Tencent ——CCB
110 1 Meituan Baba
Index Volatility (30-Day Historical) | 30.3
i 100 -
104
Index Avg. Day High-Low Range 92.34 (Nov 2023) 90 -
102 -
Correlation with HSI, CES120 (2023)| 0.987,0.936 80 - \‘\/\_/V"\
; ; 100 - r
Correlation with CSI300, FTSE A50 0.718,0.716 70 -
(2023)
98 T T T T 60
1-Nov 8-Nov 15-Nov 22-Nov 29-Nov Sep-23 Oct-23 Nov-23
Contract Multiplier HK$50 Distribution of HSCEI Index Options Ol in Month-end
Notional Value (1 Contract) HK$0.29Mn (As at 30 Nov 2023) Call Put
14.0 g0
. o s
Transaction Cost* g 120 %12‘0
~ &)
v 10.0 x10.0
Stamp Duty N/A L El
& g0 =80
. < 7]
Trading Fee HK$3.5 / contract = 60 < 6.0
=}
SFC Levy HK$0.54 / contract 8 40 40
<
Commission Rate Negotiable 0} - - o 2.0 T T )
0 10 20 30 40 50 60 70 0 20 40 60
Margin as of 24 Nov 2023 HK$22,500 Open Interest (‘000) Open Interest ('000)

Data Source: HKEX, Bloomberg
* All calculations are in HKD and exclude commission fees
Information for reference onlv

As at 30 November 2023
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Weekly HSI & HSCEI Options Performance
Weekly HSI Options

o vol

Contract Multiplier HK$50 (,\‘,’o‘_‘g‘f&mtraﬂs)

Liquidity Providers Eclipse, I-Access, IMC, Maven, Optiver 40.000 - ® Weekly HSI Options
35,000 - m Weekly HSCEI Options

Transaction Cost* 30,000
25,000

Stamp Duty N/A 20,000

Trading Fee HK$10 / contract 15,000
10,000

SFC Levy HK$0.54 / contract 5,000

Commission Rate Negotiable 0

T A A A A A A A A A A A A A A A A A A
e H A A A A A A A A A A A A A
TN P ORI ONITNORSINDIITITND D O
A NN NNNNNNM
i Volume
Weekly HSCEI Options e contracts) |
Contract Multiplier HK$50 24,000 - =\\eekly HSI & HSCEI Options Call
L . . . ==\ eekly HSI & HSCEI Options Put
Liquidity Providers Eclipse, I-Access, IMC, Maven, Optiver 20,000 - y P
16,000 -
Transaction Cost* 12,000 -
Stamp Duty N/A 8,000 -
Trading Fee HK$3.5 / contract 4,000 A
0 T T T T T T T T T T T T T T T T T T T T T
SFC Levy HK$0.54 / contract Addd A A A A d A A dAAAAAAAA A A
dddddddddddddddddddddd
Commission Rate Negotiable TNOOFOg OIS ERIINIIRZLS

An investment tool to manage short term event risk

Data Source: HKEX
* All calculations are in HKD and exclude commission fees
Information for reference onlv

As at 30 November 2023
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Equity Futures & Options
Single Stock Futures & Options

Single Stock Derivatives ADV (2023 vs 2022) _— No. of Single Stock Derivatives

Stock Futures 6,994 (-11%)

Stock Options 651,154 (+11%)

Stock Futures (YoY)

Av erage Daily Volume
(No. of Contracts)

Stock Options (YoY)

Av erage Daily Volume
(No. of Contracts)

Open Interest
(No. of Contracts)

Open Interest
(No. of Contracts)

12,000 - . ADV (L-AXis) - 40,000 800,000 - ADV (L-Axis) - 12,000,000
10,000 - Open Interest (R-Axis - 35,000 Open Interest (R-Axis)/f | 10,000,000
- 30,000 600,000 -

8,000 7 L 25,000 r 8,000,000
6,000 - - 20,000 400,000 - - 6,000,000

. - 15,000 - 4,000,000
oo 10000 200,000 ¢ - 2,000,000
2,000 - [ 5000 ,000,

0 0 T T T T T T T T T T T T 0
NDdW O A 9 N &
N N D g S
ST S S

Stock Futures (MoM)

Av erage Daily Volume
(No. of Contracts)

Stock Options (MoM)

Av erage Daily Volume
(No. of Contracts)

Open Interest
(No. of Contracts)

Open Interest
(No. of Contracts)

s ADV (L-Axis) ) 800,000 - ADV (L-Axis) - 12,000,000
10,000 Open Interest (R-Axis) 40,000 e Ope pINterest (R-AXis,
8,000 - i 600,000 -
30,000 ' - 8,000,000
6,000 -
- 20,000 400,000 -
4,000 - 200000 - 4,000,000
2,000 4 - 10,000 :

O 4 B O 0 O > > 0
olcass>c=oa= > CE8T85ZESDL0
288888532883 258828535888

202|2 2023 zozlz 2023

Data Source: HKEX
* Ol compared to previous year-end
Information for reference onlv

As at 30 November 2023

X

32,763 (-4%) Single Stock Futures
10,945,598 (+42%) Single Stock Options

Latest and Future Developments

126

Stock Futures

* Products
> 3 A-shares ETFs futures contracts
» Total 98 stock futures contracts

Stock Options

* Products
» 3 A-shares ETFs options contracts
» Total 126 stock options contracts

+ Market Makers (MMs)
» 3 types of market makers (PMM/ CQMM/
QRMM)
» CQMM to provide 50 series continuous
guotations



Hang Seng TECH Index Futures, Options and Futures Options Performance

Hang Seng TECH Index Open Interest (as of 30 November 2023)

Tracks the largest technology companies
Index Description
listed in Hong Kong Open Interest
(No. of Contracts)
400,000 -
Hang Seng TECH Index Futures & Options & Futures Options
Contract Multiplier HK$50 per index point 300,000 -
Notional Value (1 Contract) HK$195K (As at 30 November 2023) 200.000 -
No. of Liquidity Providers N/A
100,000 -
Transaction Cost* 0
Stamp Duty N/A g%g;a%gsggzg
S < i @]
Trading Fee HK$5.00 / contract DZI oo = 7 < @ = |
SFC Levy HK$0.54 / contract 202 2023
Average Daily Volume (as of November 2023)
ADV
(No. of Contracts)
140,000 -
120,000
100,000
80,000
60,000
40,000
20,000
0
Q c o] E a > c = (@) o o >
3S 2 s < £ 3> 2 § o 2
2022I 2023

Providing investors with a tool to manage their risk exposure

: ) Volume and Open Interest continue to growth
to Hong Kong-listed technology companies

Data Source: HKEX

* Exclude commission fees

Information for reference onlv

As at 30 November 2023
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MSCI China A 50 Connect Index Futures Performance

MSCI China A 50 Connect Index Average Daily Volume (as of November 2023)

L Balanced representation from 11 sectors
Index Description

of top 50 China A shares ADV
Index Level 1,839.40 (As at 30 Novermber 2023) (No. of Contracts)
20,000 -
Index Volatility (30-Day Historical) | 11.1
15,000 -
Index Avg. Day High-Low Range 12.55 (November 2023)
10,000
CSI300 Correlation (2023) 0.963
5,000
FTSE A50 Correlation (2023) 0.973
0
MSCI China A 50 Connect Index Futures
Contract Multiplier US$25 2022] 2023 |
Notional Value (1 Contract) US$0.05Mn (As at 30 November 2023) Open Interest (as of 30 November 2023)
Average Quote Size US$0.23Mn (5 Contracts)

Open Interest
(No. of Contracts)

25,000 -
Transaction Cost*
Stamp Duty N/A 20,000 -
Trading Fee US$0.5 / contract
15,000 -
SFC Levy US$0.07 / contract
Margin as of 24 Nov 2023 US$2,540 10,000 —
88 © 8 8 3 53 9% & 8 3
Al L = < s » 2 Z n O =z
2022I 2023 |
Sector-balanced exposure to China’s A-share market Risk management tool for diversified China portfolios

Data Source: HKEX
* All calculations are in USD and exclude commission fees
Information for reference onlv

As at 30 November 2023



MSCI Asia and Emerging Market Index Futures Performance

Index Description

representation 38 DM and EM countries and

regional indices

MSCI Asia and Emerging Market Index Futures

Contract Multiplier
Notional Value (1 Contract)

No. of Liquidity Providers

Transaction Cost*
Stam p Duty

Trading Fee

SFC Levy

Average US$40
Average US$45K (As at 30 November 2023)
12

N/A
US$0.6-US$1.0 / contract
US$0.07 / contract

HKEX with the broadest suite of MSCI derivatives products
based in the Asian time-zone

Data Source: HKEX
* Exclude commission fees
Information for reference onlv

As at 30 November 2023

Open Interest (As of 30 November 2023)

Open Interest
(No. of Contracts)

110,000 -+
100,000 -
90,000 -
80,000 -
70,000 -
60,000
] c Q = 5 > £ S o o 5 =
AasS ¢ s < €3> 2 § o 2
2022] 2023 |
Average Daily Volume (As of November 2023)
ADV
(No. of Contracts)
30,000 -
20,000 -
10,000 -
O_
[&] c o] E E_ > c =] (@] (o8 U >
alsS ¢ =< £ 3> 2 § o 2
2022] 2023

Volume and Open Interest continue to growth

12



MSCI AC Asia ex Japan NTR Index (AxJ) Futures Performance

Index Description

Index Level

Index Volatility (30-Day Historical)
Index Avg. Day High-Low Range
HSI Correlation (2023)

HSCEI Correlation (2023)

MSCI AxJ Futures

representation 2 DM countries (excl. Japan)
and 9 EM countries in Asia

499.07 (As at 30 November 2023)
16.9

4.67 (November 2023)

0.903

0.892

Contract Multiplier

Notional Value (1 Contract)
Avg. Quote Size

Avg. Bid-Ask Trading Spread

Liquidity Providers

US$100

US$50K (As at 30 November 2023)
US$0.25Mn (5 Contracts)

1.0 index points (November 2023)

Flow and 11 banks

Transaction Cost*

Stamp Duty
Trading Fee
SFC Levy

Margin as of 24 Nov 2023

N/A
US$0.5 / contract
US$0.07 / contract

US$1,850

Futures contracts have relatively lower transaction costs

Data Source: HKEX

* All calculations are in USD and exclude commission fees

Information for reference onlv

As at 30 November 2023

Open Interest
(No. of Contracts)

1,200 -
1,000 -
800 -
600 -
400 -
200 -

Open Interest (30 November 2023)

0

Dec

zozﬂ

c o) frt = > c = (@) o = >
g o 8 2 © 3 2 3 o KL ©
> L =2 < s 5 7 I wn O z

2023 |

MSCI AxJ Combines Developed and Emerging Markets (Rebased to 100)

MSCIAX] oo MSCI China MSCI HK

150 - MSCISG oo MSClIndia e MSCI Indonesia

------------- MSCI Korea - MSCI Malaysia MSCI Pakistan
140 1 MSCI Philippines - MSCI Taiwan MSCI Thailand
130 -
120 -
110 -
100
90
80 T T )
Sep-2023 Oct-2023 Nov-2023

MSCI AxJ is a well-established benchmark representing Asia
regional (excluding Japan) equity market performance

13



Hang Seng Mainland Banks Index Futures Performance

Hang Seng Mainland Banks Index (HSMBI) 5-Min Avg. Bid-Ask Spreads (30 November 2023)

10 largest and most representative

Index Description
2 HKEX-listed mainland banks stocks HSMBI Futures

CEB Bank 6818.HK 0.49%
Index Level 2,272.53 (As at 30 November 2023)
Minsheng Bank 1988.HK 0.47%
Index Volatility (30-Day Historical) | 20.2 ABC 1288.HK
Index Avg. Day High-Low Range 23.54 (November 2023) Bank of China 3988.HK
ICBC 1398.HK
HSCE Correlation (2023) 0.788 CITIC Bank 998.HK
CCB 939.HK
Bankcomm 3328.HK
Hang Seng Mainland Banks Index Futures CM Bank 3968.HK
Contract Multiplier HK$50
Notional Value (1 Contract) HK$0.11Mn (As at 30 November 2023)
Avg. Quote Size HK$0.57Mn (5 Contracts) Index & Constituents 3-Month Performance (Rebased to 100)
Avg. Bid-Ask Trading Spread N/A 115 - = HSMBI ——CCB (939.HK)
ICBC (1398.HK) BOC (3988.HK)
Liquidity Providers N/A ——ABC (1288.HK)
110 -
Transaction Cost* A
Stam p Duty N/A
Trading Fee HK$2 / contract 100 +
SFC Levy HK$0.54 / contract
95 T T
Margin as of 24 Nov 2023 HK$6,440 Sep-2023 Oct-2023 Nov-2023
Futures contracts have relatively lower transaction costs HSMBI Futures can be used for hedging

Data Source: HKEX, HSIL, Bloomberg
* All calculations are in HKD and exclude commission fees
Information for reference onlv

As at 30 November 2023



CES120 Index Futures Performance

CES120 Index 5-Min Avg. Bid-Ask Spreads (30 November 2023)

80 A-Shares and 40 HK-listed Mainland
China H-shares, P-chips, and red chips

Index Description
CES120 Futures | N/A

Index Avg. Day High-Low Range 55.07 (November 2023)
CSI300 Correlation (2023) 0.873

Index Level 5,050.72 (As at 30 November 2023)

Index Volatility (30-Day Historical) | 16.8

FTSE A50 Correlation (2023) 0.877

i 0,
p— ChinaAMC CS1300 ETF (3188 — 012%
Contract Multiplier HK$50
Notional Value (1 Contract) HK$0.25Mn (As at 30 November 2023)
Average Quote Size HK$1.26Mn (5 Contracts) CES120 & Top Constituents’ 3-Month Performance

Rebased to 100

Average Bid-Ask Trading Spread| N/A

120 eee=CES120 Index Tencent CCB
Liquidity Providers N/A Ping An - China Mobile
110 -
Transaction Cost* 100 -
Stamp Duty N/A 90 -
Trading Fee HK$5 / contract
80 -
SFC Levy HK$0.54 / contract
; 70 ; .
Margin as of 24 Nov 2023 HK$12,510 Sep-2023 Oct-2023 Nov-2023
Futures contracts have relatively lower transaction costs CES120 Futures can be used to hedge A-share positions

Data Source: HKEX, HSIL, Bloomberg
* All calculations are in HKD and exclude commission fees
Information for reference onlv

As at 30 November 2023



Flagship Futures - Contract Specifications

Hang Seng China Enterprises Index

Hang Seng Index Futures Hang Seng TECH Index Futures

Futures

Underlying Index
HKATS Code
Contract Multiplier
Minimum
Fluctuation

Contract Months

Pre-Market
Opening Period

Trading Hours

Last Trading Day

Final Settlement
Price

Exchange Fee

Data Source: HKEX

X

Hang Seng Index Hang Seng China Enterprises Index Hang Seng TECH Index
HSI HHI HTI

HK$50 per index point

One index point

Short-dated Futures: Spot, next three

Short-dated Futures: Spot, next three calendar month & next three calendar quarter calendar month & next three calendar
months; quarter months;
Long-dated Futures: The three months of Jun and Dec plus the next three months of Dec Long-dated Futures: The three months of
Jun and Dec

8:45 am - 9:15 am & 12:30 pm - 1:00 pm

9:15 am - 12:00 noon, 1:00 pm - 4:30 pm & 5:15 pm - 3:00 am
(Closed at 4:00 pm on the Last Trading Day)

The second last trading day of the contract month
Average quotations of the underlying index taken at five minute intervals during the Last Trading Day

HK$10.00 HK$3.5 HK$5.00

16



Flagship Options - Contract Specifications

: Hang Seng China Enterprises .
Hang Seng Index Options Index Options Hang Seng TECH Index Options

Underlying Index Hang Seng Index Hang Seng China Enterprises Index Hang Seng TECH Index
Monthly contracts: HSI Monthly contracts: HHI

HKATS Code Weekly contracts: “HSI” + Strike + Month + Weekly contracts: “HHI” + Strike + HTI
Year + “W” + Expiry Day Month + Year + “W” + Expiry Day

Contract Multiplier HK$50 per index point

Minimum Fluctuation One index point

Monthly contracts
Short-dated Options: Spot, next three calendar months & next three calendar
quarter months;
Long-dated Options: the next 3 months of Jun & Dec
and the following 3 Dec months

Monthly contracts
Short-dated Options: Spot, next three
calendar months & next three
calendar quarter months;
Long-dated Options: the next 3 months of

Contract Months /
Contract Weeks

Weekly contracts

Spot Week and the next week, except where the Expiry Day of the Weekly Contract Jun & bec
is the same as the Expiry Day of the Spot Month Contract
Exercise Style European Style
Option Premium Quoted in whole index points
Short-dated Options (monthly and weekly contracts): Long-dated Options (monthly contracts only):
Strike Price = 20,000 200 = 20,000 400
= 5,000 and < 20,000 100 = 5,000 and < 20,000 200
< 5,000 50 < 5,000 100
Trading Hours 9:15 am - 12:00 noon, 1:00 pm - 4:30 pm & 5:15 pm - 3:00 am (Closed at 4:00 pm on the Expiry Day)

The second last trading day of the contract month (monthly contracts)

Expiry Day The last trading day of the contract week (weekly contracts)

Official Settlement
Price

Exchange Fee HK$10.00 HK$3.50 HK$5.00

Average of quotations of the Index taken at five minute intervals during the Expiry Day

Data Source: HKEX

X .



Flagship Futures Options - Contract Specifications

Hang Seng Index Futures Hang Seng China Enterprises Hang Seng TECH Index Futures
Iltem : . .
Options Index Futures Options Options

Hang Seng China Enterprises Index

Underlying Index Hang Seng Index Futures Hang Seng TECH Index Futures

Futures
HKATS Code PHS PHH PTE
Contract Multiplier HK$50 per index point
Min. Fluctuation One index point
Short-dated Options: Spot, next three
Short-dated Options: Spot, next three calendar months & next three calendar months & next three calendar
Contract Months calendar quarter months and quarter months and
Long-dated Options: the next 3 months of June & December and the Long-dated Options: the next 3 months
following 3 December months of June & December after Short-dated
Options

Exercise Style European Style
Quoted in whole index points

Index points | Strike interval Index points Strike interval

Short-dated Options: Long-dated Options:

Option Premium

Strike Price > 20,000 200 > 20,000 400
> 5,000 and < 20,000 100 > 5,000 and < 20,000 200
< 5,000 50 < 5,000 100

9:15 am - 12:00 noon, 1:00 pm - 4:30 pm & 5:15 pm - 3:00 am

Trading Hours

Expiry Day
Settlement on
Exercise

Official Settlement
Price

Exchange Fee

Data Source: HKEX

X

(Closed at 4:00 pm on the Expiry Day)
The third Friday of the contract month

Physical delivery on Exercise. All in-the-money options are automatically exercised upon expiry

Average of quotations of the Index Futures Contract of the same contract month,
taken at five second intervals from 3:55 p.m. — 4:00 p.m. on the Expiry Day of the Index Futures Options

HK$10.00 HK$3.5 HK$5.0
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Hang Seng TECH Index Futures and Options Access Codes

Information Vendor Hang Seng TECH Index Futures Hang Seng TECH Index Options

AAStocks 221014 322400

ACTIV Financial HTIl/<yy><m>.HF HTIl/<yy><mm>/<strike><t>.HF
Bloomberg L.P. HCTA Index HSTECH Index OMON
Colt Technology HTImy HTI<Strikes>my

DB Power Online HTI HTI

DzZH HTI

East Money HTI

Information

ESunny Information  HTI HTI

ETNet HTI HTI

Hexin Flush HTI HTI

Infocast Ltd HTI HTI

N2N-AFE 870840 873201-7

QianLong 229

Refinitiv O#HHTI O#HTI*.HF

Shanghai Pobo HTI + Month Code

WebStock HTI HTI

Wind HTIF.HK HTIO.HK

Data Source: HKEX

X



MSCI China A 50 Connect Index Futures Access Codes

Information Vendor MSCI China A 50 Connect Index Futures

AAStocks 221790
ACTIV Financial MCA/<yy><m>.HF
Bloomberg L.P. MCYA Index
Colt Technology MCAmy
East Money Information MCA
ESunny Information MCA

ETNet MCA
Infocast Ltd MCA
N2N-AFE 870939
Refinitiv O#HMCA:
SIX Financial MCAmy
Wind MCAF.HK

Data Source: HKEX

X



MSCI Asia and Emerging Market Index Futures Access Codes

MSCI EM Asia |MSCI EM Asia
: MSCI China [MSCI China NTRJex China NTR  |ex Korea NTR MSCI EM EMEA
Information (USD) Index [Connect (USD) (USD) Index |(USD) Index (USD) Index (USD) Index NTR (USD)
Vendor Futures Index Futures Futures Futures Index Futures
Bloomberg HKCA Index  MCYA Index CSIA Index  CJEA Index HQOA Index HQRA Index HRSA Index HQTA Index
Refinitiv 0#HMAN: 0#HMCA: O#HCHI: O#HCHN: 0#HMAC: 0#HMAK: O#HEAN: O#HMEE:
WIND MANF.HK MCAF.HK EANF.HK

MSCI EM ex
Korea NTR
Information (USD) Index
Vendor Futures
Bloomberg HQIA Index HQYA Index
Refinitiv O#HMXK: O#HMEL:
WIND

. MSCI Japan |[MSCI Japan
Information [NTR (JPY) NTR (USD)
Vendor Index Futures |Index Futures

Bloomberg HQBA Index HJCA Index
Refinitiv 0#HMJJ: 0#HMJU:
WIND MJUF.HK

MSCI
_ Singapore
Information (USD) Index NTR (USD)
Vendor Futures Index Futures
Bloomberg HOBA Index  HKPA Index
Refinitiv O#HMGN: O#HMSN:
WIND

Data Source: HKEX

X

HMPA Index
O#HMEM:

HMOA Index
O#HEMN:

HLCA Index
O#HMHN:

MSCI New
MSCI Malaysia [MSCI Malaysia |Zealand NTR
(USD) Index |NTR (USD) (USD) Index
Futures
HMYA Index  HKEA Index  HOPA Index
0#HMMY: 0#HMMN: O0#HMNZ:
MMNF.HK

MSCI Taiwan
MSCI Taiwan |MSCI Taiwan [25/50 NTR
(USD) Index  [25/50 (USD) (USD) Index
Futures
HJAA Index HRCA Index HRDA Index
O#HMTW: O#HTWP: O#HTWN:
MTWF.HK

MSCI India
NTR (USD)
Index Futures

HJDA Index
O#HMIN:
MINF.HK

HRTA Index
O#HMDA:

MSCI Pacific

ex Japan NTR |[MSCI Pacific
(USD) Index NTR (USD)
Futures Index Futures
HRPA Index HRBA Index
O#HMPJ: O#HMPC:

MSCI Taiwan |MSCI Thailand
NTR (USD) (USD) Index
Index Futures |Futures

HJIBA Index HMTA Index
O#HMWN: O#HMTH:
MWNF.HK

MSCI

Indonesia

Index (USD)

Futures

HMLA Index HKBA Index

O#HMID: O#HMDN:
MDNF.HK

MSCI

Philippines

(USD) Index

Futures Index Futures
HNSA Index HLEA Index
O#HMPH: O#HMPN:

MSCI Thailand |[MSCI Vietnam
NTR (USD) (USD) Index
Index Futures |Futures
HKDA Index HNTA Index
O#HMTN: O#HMVT:
MTNF.HK

MSCI EM ex
China NTR

(USD) Index
Futures

HQDA Index
O#HMXC:

(JPY) Index
Futures

HQAA Index
O#HMJIP:

MSCI
Singapore
Free (SGD)
Index Futures
HKOA Index

0#HMSG:

MSCI Vietham
NTR (USD)
Index Futures

HKSA Index
O#HMVN:

21



Weekly HSI and HSCEI Options Access Codes

Hong Kong and International Information Vendors

AASTOCKS 322105 322125

Bloomberg HSI Index OMON HSCEI Index OMON

DB Power HSI HHI

ET Net Limited Menu "Futures/Options" > "Futures/Options Quotation (Short-term)“ > Access code: The series name
Infocast HSI HHI

MegaHub Limited HSI HHI

N2N-AFE 873101 873121

Refinitiv <O#HSIW*.HF> <O#HCEIW*.HF>

Tele-Trend File->Open->Options->HSI File->Open->Options->HHI

MSCI AxJ and MSCI AxJ Futures Access Codes

Hong Kong and International Information Vendors

AASTOCKS - 221495
Activ Financial - MXJ/<yy><m>.HF
Bloomberg M1ASJ Index MJSA Index CT
CQG - MXJ

DB Power - MXJ

East Money Information - MXJ
Factset - MXJE

ICE Data Services - F:MXJ
Infocast - MXJ
N2N-AFE - 870823
QPWeb - P11203

SIX Financial Information - MXJImy
Refinitiv .MIAX00000NUS 0#HMXJ:
Telequote Data - MXJ/<yy><m>.HF
Tele-Trend - MXJFC, MXJmyy

Data Source: HKEX

X
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Sector Index and Sector Index Futures Access Codes

Hong Kong and International Information Vendors

Information Vendor Mainland Banks
Index

AASTOCKS

Activ Financial =0200700.HK
AFE 837451
Bloomberg HSMBI Index
DB Power

ET Net MBN
Infocast HSMBI
QuotePower SEHK.HHSMBI
Telequote

Refinitiv .HSMBI

Mainland Information Vendors

Information Vendor Mainland
Banks Index

East Money HSMBI

Hexin Flush Financial

Pobo Financial

Qianlong 999905

Wind HSMBI

Data Source: HKEX

X

Mainland Banks
Index Futures

221420
MBI/16K.HF
870809
BMWA Index

MBI
MBI
MBI

P11223

MBImy
0#HMBI:

Mainland Banks
Index Futures

MBI

MBIC

MBI+Month+Year
209

MBIF+yymm+HK
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CES120 Index and CES120 Index Futures Access Codes

Hong Kong and International Information Vendors

Information Vendor | CES 120 Index | CES 120 Index Futures
Bloomberg Finance L.P. CES120 CESA Index DES <GO>
Refinitiv .HKCES120 O#HCHH:
AAStocks.com Limited 110056 221360
AFE Solutions Ltd. 837505 870800

DB Power Online Limited CES120 CHH

ET Net Limited CEC CHH
Infocast Limited CE120 CHH
Interactive Data Group I:CES120 Fn:CHH\MYYDD
Marketprizm Hong Kong Limited CES120 CHHmy
SIX Financial Information Ltd. CES120 CHHmy
Telequote Data International Limited CES120 CHHmy

Mainland Information Vendors

Information Vendor CES 120 Index CES 120 Index Futures

Hithink RoyalFlush Information Network Ltd CES120 CHHC

Shangahai DZH Limited CES120 CHH+Month Code+Year Code
Shanghai Gildata Services Co Ltd CES120 -

Shanghai Wind Information Co., Ltd CES120 CHHF+yymm+.HK
Zheng Zhou Esunny Information Technology Co,

Ltd. } CHH

Shanghai Wenhua Financial Information Ltd - CHHmy

Shanghai Qianlong Advanced Technology Co Ltd CES120 Page 209

Data Source: HKEX

X
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